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Introduction
These release notes describe new features, requirements, restrictions, and caveats for all versions of Cisco
Jabber for Windows Release 11.0.x and 11.1.x. These release notes are updated for every maintenance release
but not for patches or hot fixes. Note that each maintenance release includes the features, requirements,
restrictions, and bug fixes of the previous releases unless mentioned otherwise. Before you install Cisco Jabber
for Windows, we recommend that you review this document for information about issues that may affect your
system.

Build Number
Build NumberRelease

11.1.4.44590Release 11.1(4)

11.1.3.27055Release 11.1(3)

11.1.2.24949Release 11.1(2)

11.1.1.22531Release 11.1(1)

11.1.0.21135Release 11.1

11.0.1.19000Release 11.0(1)

11.0.0.65527Release 11.0

What's New in Release 11.1(4)

Updated JCF Library

The Cisco Jabber Client Framework (JCF) Components includes a version of the 'LibTiff' library that is
affected by the vulnerabilities identified by the following Common Vulnerability and Exposures (CVE) IDs:
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CVE-2013-1961, CVE-2013-1960, CVE-2013-4244, CVE-2013-4243, CVE-2012-4447, CVE-2012-3401,
CVE-2015-1547, CVE-2014-9655, CVE-2013-4231

The LibTiff library has been removed from the JCF component. This vulnerability has been resolved with
caveat CSCva89914.

What's New in Release 11.1(3)

Resolved Caveats

This release provides fixes for a number of known issues. See the Resolved Caveats in Release 11.1(3) section
for a list of caveats fixed in this release.

What's New in Release 11.1(2)

Cut and Paste in IMs

You can configure whether users are allowed to copy or cut text and paste it into a chat window. Configure
this behavior in Cisco Unified CM IM and Presence Administration >Messaging > Settings with the
Allow cut & paste in instant messages check box.

Configurable Domain for Exchange Authentication

To save chat history to an Outlook folder, you must specify an authentication method to the Exchange Server.
Use the new ExchangeDomain parameter to specify the domain of the Exchange server. For more information
about the ExchangeDomain parameter, see the Cisco Jabber 11.0 Parameters Reference Guide.

What's New in Release 11.1(1)

Configurable System Language

The new parameter UseSystemLanguage determines which language is used for Cisco Jabber. The default
value for this parameter is false.

The Cisco Jabber language is determined using the following logic:

1 The system checks the bootstrap file. If the language is specified in the bootstrap file (using the
LANGUAGE parameter), then the specified language is used.

2 If the language is not specified in the bootstrap file, then the following logic applies:

• If the UseSystemLanguage parameter is set to true in the jabber-config.xml file, then the language
is set to the same value as the operating system.

• If the UseSystemLanguage parameter is set to false in the jabber-config.xml file (or not included at
all), then Cisco Jabber uses the regional language as specified by the user. The regional language is
set atControl Panel >Clock, Language, and Region >Region and Language >Change the date,
time, or number format > Formats tab > Format dropdown.
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When this parameter is specified in the jabber-config.xml file on a TFTP server, it becomes effective only
after the client is restarted (File > Exit).

Note

For more information about parameters, see the Cisco Jabber Deployment and Installation Guide.

Build Number Reported to Cisco Unified Communications Manager

The exact Cisco Jabber for Windows build number is reported to Cisco Unified Communications Manager.
The build number can be seen from theDevice Settings and Phone Configurationwindows on Cisco Unified
Communications Manager.

Automatic Sign-in Option Enabled with Installation

A new installer parameter, AUTOMATIC_SIGN_IN, allows you to check the Signme in when Cisco Jabber
starts check box when the user installs Cisco Jabber. The default value for this installer parameter is false.
For more information about command line arguments, see the Cisco Jabber Deployment and Installation
Guide.

What's New in Release 11.1

IBM Notes Contact Search

Users can now search for and add local IBM Notes contacts to their contact lists. Configure this feature with
the new EnableLotusNotesContactResolution parameter. The default value for this parameter is false, meaning
that users cannot search for or add local IBM Notes contacts. For more information about the
EnableLotusNotesContactResolution parameter, see the Cisco Jabber 11.0 Parameters Reference Guide.

For this contact resolution to work properly, the Messaging ID field in IBM Notes must have a valid value.

Users cannot add contacts from both Microsoft Outlook and IBM Notes.Note

Jabber to Jabber Calling

This feature applies to cloud deployments only.

Jabber to Jabber calling provides basic voice and video calling between Cisco Jabber clients without Cisco
Unified Communications Manager registration. Jabber to Jabber calling is supported only for users who
authenticate to the Cisco WebExMessenger service. Multiple Jabber to Jabber calls are not supported. Jabber
to Jabber calling supports the following basic calling features:

• Make a Jabber to Jabber call

• Answer a Jabber to Jabber call

• End a Jabber to Jabber call

• Mute and unmute audio

• Start and stop video

• Open or close video self-view
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• Volume control

Before you enable the Jabber to Jabber calling feature, contact the Cisco Customer Support team or your
Cisco Customer Success Manager for the following:

Note

• To request that your organization be added to the Cisco Common Identity server. This process to
add users to the Common Identity server takes some time to complete and is necessary to access
Jabber to Jabber calling capabilities.

• For single sign-on (SSO) users, there are extra steps to perform to ensure that SSO setup is completed
successfully for your organization.

For more information about Jabber to Jabber calling, see the Jabber to Jabber Call section of theCisco Jabber
11.0 Deployment and Installation Guide.

Documentation Improvements

Cisco Jabber for Windows end-user documentation, including videos and getting started content, is now also
available on the Help Central knowledge base at https://help.webex.com/community/jabber. Documentation
for system administrators remains at http://www.cisco.com/c/en/us/support/unified-communications/
jabber-windows/tsd-products-support-series-home.html.

Information about Cisco Jabber parameters has been removed from the Cisco Jabber 11.0 Deployment and
Installation Guide and included in a new document titled Cisco Jabber 11.0 Parameters Reference Guide.
You can find this new document at this link: http://www.cisco.com/c/en/us/support/unified-communications/
jabber-windows/products-installation-guides-list.html

What's New in Release 11.0(1)

Compliance and Audit Support for IM-only Screen Sharing

For all IM-only screen sharing events, you can now configure Cisco Jabber clients to send information about
all user actions to the Presence server for compliance or auditing purposes. This feature is useful if you want
to collect information about IM-only screen sharing, for example, users who initiate screen shares, users who
accept screen share invites, users who request control during screen shares, or users who end screen shares.
Configure this support with the ScreenShareAuditMessages parameter. The default value is false, whereby
Cisco Jabber does not send any information to the Presence server about user actions during IM-only screen
sharing.

If you want to enable this feature, ensure that all Cisco Jabber clients are running at least release 11.0(1).
If some clients are running older versions, the information that is collected during IM-only screen sharing
is sent to the older Cisco Jabber clients as instant messages.

Note
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Administrator Control of Saving Chats to Microsoft Outlook

This release provides greater Administrator control of the feature to save chats to Microsoft Outlook. The
EnableSaveChatHistoryToExchange parameter has been removed and replaced with a new parameter
SaveChatHistoryToExchangeOperationMode, which can have one of the following values:

• DisabledByPolicy—This is the default value. Users cannot save chat history to Microsoft Outlook. The
Outlook tab of the Options menu is not visible.

• EnabledByPolicy—Chats are saved to Microsoft Outlook. The option Save chat sessions to "Cisco
Jabber Chats" Folder in Microsoft Outlook is visible on the Outlook tab of the Options menu, but it
is greyed out and users cannot change it.

With this option, you must set up a method of authentication for the client to authenticate
with the Exchange server. You can choose to authenticate using single sign-on, or by
synching credentials. See the Cisco Jabber 11.0 Deployment and Installation Guide for
more information.

Note

• DisabledByDefault—Users have the option to save chats to Microsoft Outlook. The option Save chat
sessions to "Cisco Jabber Chats" Folder in Microsoft Outlook is unchecked on the Outlook tab of
the Options menu, but users can change it.

• EnabledByDefault—Users have the option to save chats to Microsoft Outlook. The option Save chat
sessions to "Cisco Jabber Chats" Folder in Microsoft Outlook is checked on the Outlook tab of the
Options menu, but users can change it.

Work Number Shown in Microsoft Outlook 2010 Contact Card

In previous releases, when URI Dialing is enabled and Cisco Jabber is running, Microsoft Outlook 2010
contacts show the SIP URI in the click-to-call menu, but no phone number is shown in the contact information.
The phone number is shown when Cisco Jabber is not running. This is a known limitation with Microsoft
Outlook 2010. In Microsoft Outlook 2013, both the SIP URI and the phone number are shown when Cisco
Jabber is running.

With release 11.0(1), the business phone number is shown as the default for click-to-call from Microsoft
Outlook 2010.

Email Subject Field in Group Chat Topic Label

When users launch a group chat from a Microsoft Outlook email, the group chat topic is prepopulated with
the Subject field of the email. Users can edit the topic in the group chat pop-up prior to starting the group
chat.

SIP URI Support in Contact Source Phone Fields

In previous releases, Cisco Jabber did not recognize SIP URIs in phone number fields in any contact source,
and converted each SIP URI to a numeric value in the user profile window. With this release, SIP URI values
are now maintained and displayed correctly in the user profile window.

Administrator Control of Extend and Connect Device Editing for Users with Multiple Devices

In previous releases, the Extend and Connect functionality operates as follows:
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• Users with a single extend and connect device and no other devices cannot edit or add new remote
destinations. You can allow users to edit or add remote destinations by setting the
UserDefinedRemoteDestinations parameter to true.

• Users with multiple devices can always edit or add remote destinations. This is not configurable.

With this release, the RemoteDestinationEditingWithMultipleDevices parameter allows you to determine
whether users with multiple devices can edit or add remote destinations. Set this parameter to false to disallow
users with multiple devices to edit or add remote destinations. The default value for this new parameter is
true.

Read-only Username on Sign In Screen after Successful First Login

A new parameter,MakeUsernameReadOnly, provides the option to make the Username field on the Sign
In screen read-only after the user logs in successfully for the first time. The default setting for this parameter
is false. When set to true theMakeUsernameReadOnly parameter delivers the following user experience:

• On first login, the Username field is available for user input.

• After a successful login, theUsername field becomes read-only on the Sign-in screen for all subsequent
logins.

• To reenable the Username field, or to switch to a different user, users must reset Cisco Jabber from the
File menu.

New Chat Font Sizes

Two new font sizes have been added, sizes 8 and 9. Font size 10 remains the default font size for chats.

New Emoticons

29 new emoticons have been added.

What's New in Release 11.0

Calling Features

• Far End Camera Control—For devices that support it, you can direct cameras on the other end of
video calls and control the screen layout during conference calls. An icon is displayed in calls using
cameras with far end camera control that you can use to pan, tilt and zoom the far end camera. This
feature is only available to users in softphone mode.

• Collaboration Meeting Room Conferencing—With one click, escalate an IM conversation to audio
and video conferencing using Cisco Cloud Collaboration Meeting Rooms (CMR).

•WebEx Personal Room Conferencing—With one click, escalate an IM conversation to audio and
video conferencing using Cisco Webex Personal Rooms (Webex PR).

• Audio and Video Bridge Conferencing—With one click, escalate an IM conversation to audio and
video conferencing using standards-based third party conferencing solutions

• DTMF Digit Management—While on a call, cut and paste DTMF digits to enter a PIN number. You
can also include DTMF digits with your protocol handlers to create links that participants can use to
quickly access their meetings. Use commas after phone numbers and prior to DTMF numbers to denote

   Cisco Jabber for Windows 11.0.x and 11.1.x Release Notes
6

Introduction
What's New in Release 11.0



a one second pause; you need at least one comma to indicate DTMF digits. For example, if you have a
meeting with dial in number of 1800-123456, and an PIN for entry of 5678#, then you can use tel uri in
the format tel:1800123456,,,5678# to enter the meeting with one click.

• Headset Selection from Conversation Windows—You can now select your connected audio device
directly from your conversation windows.

• Opus Codec Support—The Cisco Jabber client now supports the Opus audio codec. Use of the Opus
codec requires Cisco Unified Communications Manager 11.0.

• SennheiserHeadset Support for CallManagement—Use Sennheiser accessories to control your calls
on Cisco Jabber to adjust call volume, answer and end phone calls, and mute.

• Click-to-Call Keyboard Shortcut—Configure theMakeCallHotKey parameter to make a Cisco Jabber
call using an administrator-defined global keyboard shortcut that is active from any application on your
desktop. The default shortcut is CTRL+SHIFT+J and is enabled by default. For more information on
configuring this parameter, see the Cisco Jabber 11.0 Parameters Reference Guide

• Clicktocall: URI Handler—Cisco Jabber supports registering as the clicktocall: URI handler.

• ConversationWindowControl for All Calls—Extended beyond deskphone control, you can now also
control the conversation window behavior for calls when using softphone using the
DeskphoneModeWindowBehavior and SoftphoneModeWindowBehavior parameters.

• Display Call Duration—You can see the duration of calls displayed in your Recents tab when you
hover over your calling history.

• Classic Ringtone—You can select a traditional ringtone for your incoming calls.

• Hide Call Controls—If your users use Cisco Jabber for calls, but manage their calls using another
application, then you can disable the call control strip on the calling window so that users are presented
with video-only window. You can enable this feature using the HideCallControlStrip parameter, which
is disabled by default. For more information on setting up this feature, see the Cisco Jabber 11.0
Parameters Reference Guide

• Chat Reply—A new option for incoming calls from contacts whereby the call is automatically forwarded
to your voicemail. A chat window with the caller also pops up, giving you the option to send a quick
reply to the caller.

Chat and Presence Features

• Enterprise Groups for Cisco Unified Communications Manager—You can add an enterprise group
to your Cisco Jabber contacts using the Microsoft Active Directory (AD) groups in your enterprise.
Because the group is maintained in your corporate directory, your client contact list is updated dynamically
to synchronize with the directory group. Directory groups require Cisco Unified Communications
Manager IM and Presence Service 11.0. If a group contains more than 100 people, then no presence is
displayed for those contacts. For cloud deployments, enterprise groups are already supported in the
client.

• Play Sounds for Chat Messages—Choose whether to play sounds for all messages or only for the first
message per conversation.

• Contact Card on Hover—Users' contact card is displayed when you hover over the contact in your
Contact list. This feature is enabled by default, but to disable it or read more about it, see
ContactCardonHover parameter description in the Cisco Jabber 11.0 Parameters Reference Guide.
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• Alert When Available from Conversation Windows—Set the Alert When Available feature from the
conversation window with your contact.

•Windows Taskbar Shortcuts—Set your presence, sign out, and exit the client directly from theWindows
taskbar.

• Telephony and Chat URIs in Chat window— Click on telephony and chat URIs in chat windows to
initiate calls and chats.

• UNC Links in Chat window—Use UNC links such as file: in the Jabber chat window.

• Save Chat to Outlook for Office 365—Save Cisco Jabber chats to a folder in your Microsoft Outlook
365. This enhancement is an addition to the support for saving chats to a folder in Microsoft Outlook
for on-premises deployments. For more information on configuring this feature, see the Options
Parameters and Save Chat History to anOutlook Folder sections in theCisco Jabber 11.0 Deployment
and Installation Guide.

Persistent Chat Features

• Search from Persistent Chat Rooms—Search directly from persistent chat rooms.

• Persistent Chat Room Conferencing—Escalate your persistent chat room conversations to audio and
video conferencing using Cisco Collaboration Meeting Rooms and WebEx Personal Rooms, or from
other conferencing solutions. Use the pChatMeeting parameter to set up this feature. For more information,
see Cisco Jabber 11.0 Parameters Reference Guide.

• Screen Sharing in Persistent Chat Rooms—Share your screen with other participants in a persistent
chat room. Use the pChatShare parameter to set up this feature. For more information, see the Cisco
Jabber 11.0 Parameters Reference Guide.

Sharing Features

• IM Only Share: Groups of 10— You can now share your screen from an IM with groups of up to 10
Cisco Jabber for Windows users.

Platform Features

• Intel Atom Support—Support for Intel Atom processor-based Windows devices.

•Windows 10—Support Windows 10 OS release in Windows desktop mode.

Security Features

• Encryption and Decryption of PRTs—Configure the encryption and decryption of PRTs using
theEnablePrt, EnablePrtEncryption, and PrtCertificateName parameters. For more information on
configuring these parameters, see the Cisco Jabber 11.0 Parameters Reference Guide.

For more information about your privacy rights and the Cisco Problem Reporting Tool (PRT), see the
Jabber Supplement to the Cisco Privacy Statement at www.cisco.com/web/siteassets/legal/jabber_
supp.html.

• PRT Logging Levels—Configure different logging levels for PRTs using the new LogWritingDesktop
and DetailedLogDurationDesktop parameters. For more information on configuring these parameters,
see the Cisco Jabber 11.0 Parameters Reference Guide.
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• Invalid Certificate Behavior—Configure how the client handles invalid certificate policies with the
INVALID_CERTIFICATE_BEHAVIOR installation parameter. For more information on how to
configure this installation argument , see theCommon Installation Arguments section of theCisco Jabber
11.0 Deployment and Installation Guide

Requirements

Software Requirements

SoftwareServer

• Microsoft Windows 10, 32 bit and 64 bit (Desktop OS x86)

• Microsoft Windows 8.x, 32 and 64 bit

• Microsoft Windows 7 SP1 or later, 32 and 64 bit

Operating systems

• Cisco Unified Communications Manager version 8.6(2) or later

• Cisco Unified Presence version 8.6(2) or later

• Cisco Unity Connection version 8.6(2) or later

• Cisco WebEx Meetings Server version 1.5 or later

• Cisco Expressway Series for Cisco Unified Communications Manager 8.6.2 or
later

• Cisco TelePresence Video Communication Server 8.1.1 or later

On-premises
servers

• Citrix XenDesktop 7.6, 7.5, 7.1

• Citrix XenApp 7.6 published desktop, 7.5 published desktop, 6.5 published
desktop

• VMWare Horizon View 6.1, 6.0, 5.3

Virtual servers

• Cisco WebEx Messenger service

• Cisco WebEx Meeting Center, version WBS28 or later

Cloud-based
servers

• Active Directory Domain Services for Windows Server 2012 R2

• Active Directory Domain Services for Windows Server 2008 R2

• OpenLDAP 2.4 and later

• Active Directory Lightweight Directory Service (AD LDS) or Active Directory
Application Mode (ADAM)

Directory servers
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SoftwareServer

• Cisco Unified Communications Manager version 9.1(2) with the following COP
file:
cmterm-cucm-uds-912-5.cop.sgn.

• CiscoUnified CommunicationsManager version 10.0(1). No COP file is required.

User Data Service

Hardware Requirements

RequirementHardware

2 GB RAM on Microsoft Windows 7 and Windows 8Installed RAM

128 MBFree Physical
Memory

256 MBFree Disk Space

• Mobile AMD Sempron Processor 3600+ 2 GHz

• Intel Core2 CPU T7400 at 2. 16 GHz

• Intel Atom

CPU Speed and
Type

DirectX11 on Microsoft Windows 7GPU

USB 2.0 for USB camera and audio devices.I/O Ports

Network Requirements

Ports and Protocols

DescriptionProtocolPort

XMPP traffic to the WebEx Messenger service.

The client sends XMPP through this port in cloud-based
deployments only. If port 443 is blocked, the client falls
back to port 5222.

Cisco Jabber can also use this port for:Note

• HTTPS traffic to Cisco Unity Connection and
Cisco WebEx Meetings Server.

• Saving chats to the Microsoft Exchange
server.

TCP

(ExtensibleMessaging
and Presence Protocol
[XMPP] and HTTPS)

443
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DescriptionProtocolPort

The client uses this port for far end camera control.UDP30000 to 39999

Range of media ports used for RTP/SRTP for video calling.
The port 33434 is used to enable video calling.

UDP/TCP33434-33598 and
8000-8100

Lightweight Directory Access Protocol (LDAP) directory
server.

UDP/TCP389

LDAP directory server (secure).LDAPS636

Computer Telephony Interface (CTI) used for desk phone
control.

TCP2748

Global Catalog server.TCP3268

Global Catalog server (secure).LDAPS3269

Binary Floor Control Protocol (BFCP) for video desktop
sharing capabilities.

UDP5070 to 6070

XMPP traffic to Cisco Unified Presence or Cisco Unified
Communications Manager IM and Presence Service.

TCP

(XMPP)

5222

Traffic to Cisco Unified Communications Manager and
Cisco Unified Communications Manager IM and Presence
Service.

TCP

( HTTPS )

8443

Cisco Unity Connection for notifications of voice messages
(new message, message update, and message deletion).

TCP

( HTTPS )

7080

Domain Name System (DNS) traffic.UDP/TCP53

Saving chats to Microsoft Exchange server.

Depending on your server configuration on Microsoft
Exchange, use either port 80 or 443, but not both.

HTTP80

Peer-to-peer file transfers.

In on-premises deployments, the client also uses this port to
send screen captures.

SOCKS5Bytestreams37200

Session Initiation Protocol (SIP) call signaling.UDP/TCP5060

Secure SIP call signaling.TCP5061
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DescriptionProtocolPort

IM-only screen share.

The client randomly selects a port from the range.

The actual range may vary. To find the real range, enter the
netsh interface ipv4 show dynamicportrange tcp
command.

You can use the SharePortRangeStart and
SharePortRangeSize parameters to narrow the range used
for IM screen share. For more information on these
parameters, see the section on Common Policies parameters
in the Deployment and Installation Guide.

TCP49152 to 65535

Third-Party Requirements

RequirementThird-Party Software

Microsoft Internet Explorer 9 or laterMicrosoft Internet
Explorer

• Microsoft Office 2013, 32 and 64 bit

• Microsoft Office 2010, 32 and 64 bit

Microsoft Exchange integrates directly with Cisco Unified CommunicationsManager.
For more information, see the Configuration Guides for the appropriate version of
Cisco Unified Communications Manager.

Microsoft Office

• Microsoft SharePoint 2013

• Microsoft SharePoint 2010

Microsoft SharePoint

Cisco Jabber for Windows supports client-side integration with Microsoft Office 365
with the following applications using an on-premises Active Directory (AD)
deployment:

• Microsoft Office 2013

• Microsoft Office 2010

• Microsoft SharePoint 2010

Microsoft 365
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RequirementThird-Party Software

• Microsoft Outlook 2013, 32 and 64 bit

• Microsoft Outlook 2010, 32 and 64 bit

• IBM Lotus Notes 9 32 bit

• IBM Lotus Notes 8.5.3 32 bit

• IBM Lotus Notes 8.5.2 32 bit

• IBM Lotus Notes 8.5.1 32 bit

• Google Calendar

Third-party
calendars

Antivirus Exclusions

If you deploy antivirus software, include the following folder locations in the antivirus exclusion list:

• C:\Users\<User>\AppData\Local\Cisco\Unified Communications\Jabber

• C:\Users\<User>\AppData\Roaming\Cisco\Unified Communications\Jabber

• C:\ProgramData\Cisco Systems\Cisco Jabber

Limitations and Restrictions

Limitations and Restrictions for All Deployments

IBM Notes Contact Search

Jabber doesn't support searching for IBM Notes contacts using " or \ as the first character in the search string.

Call History Limit

The client can store up to 250 entries in your call history.

Call Transfers

When you are transferring a call to a third party, the third party must respond to the call before you can
complete the transfer. You cannot currently dial the third party and connect the first party while waiting for
the call to connect (also known as a blind transfer).

Certificate Requirements for Non-Domain Computers

All computers that run Cisco Jabber must have both base and delta Certificate Revocation List (CRL) files.
Computers within the domain automatically get these files, but computers outside of the domain require
manual installation of the base and delta CRL files. These files are required for Cisco Jabber to trust to the
Cisco WebEx Meetings Server certificate.
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Chat Reply and No Voicemail Profile

The chat reply feature does not work if the user has no voicemail profile configured. If the user selects Chat
reply in an incoming call, the call continues to ring and the Chat reply and Answer options are greyed out.
This limitation is documented in CSCux75667.

Check Point VPN

Cisco Jabber for Windows does not currently support Check Point VPN. This limitation is documented in
CSCuy34099.

Cisco AnyConnect Secure Mobility Client

Cisco Jabber for Windows supports Cisco AnyConnect Secure Mobility Client version 4.0 and later. This
limitation is documented in CSCuy14721.

Cisco Medianet Support

The Cisco Medianet Metadata feature is no longer supported in Cisco Jabber for Windows.

The Cisco Medianet CDP driver leveraged by the Cisco Jabber desk phone video feature is supported for
Windows 7 & 8 deployments. The desk phone video feature and Cisco Medianet CDP driver installation are
not supported on Windows 10 workstations.

Cisco Unity Connection Dispatch Messages

In Cisco Unity Connection, a dispatch message is sent to a distribution list with the message configured in
such a way that only one user responds to that message. A user can accept, decline, or postpone the dispatch
message. Cisco Jabber for Windows does not support Cisco Unity Connection dispatch messages. This
limitation is documented in CSCuw31908.

Configuration Parameters for Photo Retrieval

Include the configuration parameters for photo retrieval in the global configuration XML file
(jabber-config.xml). If you include them in the group configuration XML file, photo retrieval might fail.

Emails to a Group of Contacts

There is a limit of 2083 characters in the To field when sending an email to a group of contacts. Depending
on the length of the email addresses and the number of contacts, not all contacts may be added to the email.
For more information about the 2083 character limitation, see https://support.microsoft.com/en-ie/kb/208427.
This limitation is documented in CSCuz80198.

High DPI Devices

Cisco Jabber for Windows does not support IM-only screen share in a high DPI environment. This limitation
is documented in CSCuw50217.

Location Feature and Multiple Domain Support in Release 11.1

Consider the following deployment scenario:

When you deployed your Cisco Unified Communications Manager IM and Presence Service node, all users
were imported with single domain support. You later changed the address scheme to Directory URI (multiple
domain support).
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The location feature will now not work for newly added domain users. Users in the initial domain are unaffected.
This limitation is documented in CSCuu76519.

Microsoft Outlook Local Contacts and Presence

Users' presence is unknown when the contact is manually added to contacts in Microsoft Outlook 2010 and
2013, when the contact is added to local (custom) contacts with an email address type of SMTP. To resolve
this issue, delete the contact and add it again manually, ensuring the email address type is Exchange (EX).
This item is documented in CSCuo57172.

Plantronics Accessories and Software

If you use Plantronics accessories for Cisco Jabber call management, and if you have Plantronics Hub installed,
ensure that at least version 3.5 is installed. Download Plantronics Hub 3.5 from the Plantronics website.

Remote Desktop Control over Mobile and Remote Access

Remote desktop control over Mobile and Remote Access is not supported.

SAML Single Sign-On Limitations

When configuring SAML SSO on Cisco Unified Communications Manager and Cisco Unity Connection
servers, use a fully qualified domain name (FQDN) instead of an IP Address to define the server name. If you
use an IP Address, the client displays a warning message that the certificate is not valid. The requirement to
use an FQDN is because the embedded Internet Explorer browser is not able to validate IP addresses in the
Subject Alternate Name (SAN) certificate.

Space Characters in Credentials

The following rules apply to space characters and credentials:

• Usernames can contain spaces in on-premises deployments.

• Usernames cannot contain spaces in cloud-based deployments.

• Passwords cannot contain spaces in any deployment scenario.

• The first and last characters of usernames in on-premises deployments must not be spaces. This rule is
also true for usernames synchronized from a directory source.

Special Characters in Usernames or Passwords

The ASCII printable character set is supported, except for space and delete. The ASCII control and extended
character sets are not supported, such as ü, Ü, ä, or ö. Using these characters with Cisco Jabber for Windows
will result in softphone registration failure. The following error message is displayed: “Invalid username
or password entered. Go to Phone Services in the Options window and enter
the correct username and password".

Standard CTI Secure Connection User Group

Cisco Jabber for Windows does not currently support CTI connections over transport layer security (TLS).
As a result, Cisco Jabber for Windows users cannot switch from using a CSF device to using a desk phone
device if they belong to the Standard CTI Secure Connection user group. This limitation is documented in
CSCux83786.
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Upgrades from Release 10.6.6

If you are upgrading from Cisco Jabber Release 10.6.6, complete the following procedure:

1 Uninstall Cisco Jabber.

2 Delete all the files in C:\Program Files (x86)\Cisco Systems\Cisco Jabber\

3 Install Cisco Jabber 11.0(x)

If you do not remove all the files from the specified location, installation of Cisco Jabber 11.0(x) will fail.

Using Click-To-X Feature with Contacts in Microsoft Outlook

If you use UDS as a directory source, users can only use Click-To-X capabilities, such as Click-To-Call and
Click-To-IM, to contact Microsoft Outlook users if they are already in the cache file. A cache file is created
for someone if they are in the users' Cisco Jabber contacts list, or have a Cisco Jabber history created by the
user previously searching, IMing, or calling them, or by leaving a voice message.

Limitations and Restrictions For On-Premises Deployments

Adding Federated Contacts

When adding federated contacts, Cisco recommends that users add the federated contacts as company contacts
(File > New > Company Contact), rather than as custom contacts. Adding federated contacts as custom
contacts can cause intermittent presence issues. This issue is documented in CSCuz59060.

Creating and Configuring Devices for Users in Cisco Unified Communications Manager 11.0

If you are creating devices for users in Cisco Unified Communications Manager 11.0, you can now specify
a key order as RSA Only, EC Only or EC Preferred, RSA Backup. However, the EC Only option is not
currently supported by Cisco Jabber, and if you select it, the client will fail to connect to the server.

Multiple Resource Login

When a user signs in to multiple instances of the client at the same time, the chat feature behaves as follows
in on-premises deployments (more on multiple resource login in Common Deployment Scenarios):

• Signing in on one client changes custom availability states to 'Available' on other clients.

• If you set the availability state from 'On a call' to another state while on a call, the availability state does
not automatically change to 'On a call' for subsequent calls.

Space Characters in Credentials

The following rules apply to space characters and credentials in on-premises deployment scenarios:

• Usernames can contain spaces in on-premises deployments.

• Passwords cannot contain spaces in any deployment scenario.

• The first and last characters of usernames in on-premises deployments must not be spaces. This is also
true for usernames synchronized from a directory source.
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Server Presence Issue in Client

If you use Cisco Unified Presence 8.6.5 SU2 or earlier, or Cisco Unified Communications Manager IM and
Presence 9.1.1 SU1 or earlier, the client might display users' presence as offline when the user is actually
online and has a network connection. This presence issue is fixed in Cisco Unified Presence 8.6.5 SU3 and
Cisco Unified Communications Manager IM and Presence 9.1.1 SU1 and 10.0.1. This item is documented in
CSCui29999.

Contacting Federated Users After Changing Privacy Policies

Users may experience issues contacting federated users in the scenario below when the privacy policy is
changed:

1 Users add federated contact to their contact lists.

2 Users change the policy for contacts outside the domain from Prompt me every time to Block everyone
on the Privacy tab of the Options window.

As a result, the federated contacts remain in the contact list but do not display availability. Likewise, users
cannot send or receive instant messages from those federated contacts.

3 Users change that policy from Block everyone to Prompt me every time.
As a result, Cisco Unified Presence removed the federated contacts from the contact lists. Cisco Unified
Presence does not repopulate the federated contacts.

Limitations and Restrictions For Cloud Deployments

Blocking Users in Enterprise Groups

Blocking users does not prevent a blocked user's status from being displayed if the blocked users are in a
contact list as part of an enterprise group. For example, User A blocks User B. However, User A is in User
B's contact list as part of an enterprise group. As a result, User B can view User A's availability status.

Invitees to Instant WebEx Meetings

Invitees to instant WebEx meetings must be provisioned with WebEx accounts before they can join an instant
WebEx meeting. For example, User A has a WebEx account and starts an instant WebEx meeting from Cisco
Jabber. Use A then invites User B, who does not have a WebEx account, to the meeting. When User B clicks
on the meeting link in Cisco Jabber, an error message is displayed and the user can't join the meeting. User
B must be provisioned with a WebEx account before attempting to join any instant WebEx meetings.

Jabber to Jabber Calls

For Release 11.1, we recommend running Internet Explorer 10 or greater while using the Jabber to Jabber
calling feature. Using this feature with previous versions of Internet Explorer or with Internet Explorer in
Compatibility Mode can cause issues with Cisco Jabber client login (non-SSO setup) or Jabber to Jabber
calling capability (SSO setup).

Photo Display

In late 2011, the WebEx server made changes to how photos are stored and formatted on the server. Due to
this change, any photo uploaded before January 1, 2012 is not displayed in the client. To resolve the issue,
users must re-upload the photo. For more information on this item, see CSCui05676.
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Users in Common Identity

There is a known issue with signing into Cisco Jabber for some users who have migrated to Common Identity.
If users receive an Incorrect user name or password error message when entering their username and password,
see the following knowledge base article https://cisco-support.webex.com/guest/articles/en_US/Troubleshooting/
WBX000019555/myr=false

Performance and Behavior Notes

Display Name Changes in Corporate Directory

When a user's first name or last name is changed either in LDAP or UDS directories, Cisco Jabber does not
automatically update this information in the contact list for all watchers of this user. Users must manually
update their contact lists using the following procedure:

1 Remove the contact from their contact list.

2 Sign out of Cisco Jabber.

3 Reset Cisco Jabber.

Click the gear icon and select File > Reset Cisco Jabber.

4 Sign in to Cisco Jabber again.

5 Add the contact again.

Jabber to Jabber Calls and Symantec Host IDS (HIDS)

Jabber to Jabber calls can trigger errors in Symantec HIDS.

Symantec HIDS has a rule that disables connections from internet-based servers if it receives 5 connection
requests from the same internet-based server within 200 seconds. For example, 3 Jabber to Jabber calls within
200 seconds will trigger Symantec HIDS. When this happens, ongoing Jabber to Jabber calls are dropped and
Jabber to Jabber calls are disabled for 600 seconds.

To avoid this scenario, you must add Cisco Jabber to the Symantec exception list.

Meeting Reminders

Cisco Jabber displays pop-up reminders for Cisco WebEx meetings only. Reminders for non-Cisco WebEx
meetings are not displayed.

Two meeting reminders are displayed for a meeting. One reminder displays the Time to join message. The
other reminder includes aMeeting details link. Both reminders are sent automatically by the meeting host at
the meeting start time. This behavior is documented in CSCuz06684.

If the URL for aWebExmeeting is changed (for example, by URL filter software), attempts to join the meeting
from the meeting reminder or from the Meetings tab fail.

Phone-only Mode after Cisco Unified Communications Manager IM and Presence Service Upgrade

For on-premise deployments, if Cisco Unified CommunicationsManager IM and Presence Service is upgraded
from release 9.1(1) to release 10.5(2) and clients appear in phone-only mode after the upgrade, then all clients
must be reset.
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Removing Participants During Conference Calls

Users can only remove participants from a conference call when using the softphone(CSF) device for calls.
Users can't remove participants from conference calls in desk phone control mode or using extend and connect.

Caveats
Caveats describe unexpected behavior. The following sections describe how to obtain the latest information.

Bug Severity Levels
Known defects, or bugs, have a severity level that indicates the priority of the defect. These release notes
include the following bug types:

• All severity level 1 or 2 bugs

• Significant severity level 3 bugs

• All customer-found bugs except severity level 6 enhancement requests

DescriptionSeverity Level

Reasonably common circumstances cause the entire system to fail, or a major subsystem
to stop working, or other devices on the network to be disrupted. No workarounds exist.

1 Catastrophic

Important functions are unusable and workarounds do not exist. Other functions and the
rest of the network is operating normally.

2 Severe

Failures occur in unusual circumstances, or minor features do not work at all, or other
failures occur but low-impact workarounds exist.

This is the highest level for documentation bugs.

3 Moderate

Failures occur under very unusual circumstances, but operation essentially recovers
without intervention. Users do not need to install any workarounds and performance
impact is tolerable.

4 Minor

Defects do not cause any detrimental effect on system functionality.5 Cosmetic

Requests for new functionality or feature improvements.6 Enhancement
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Search for Bugs
To search for bugs not listed here, use the Bug Search Tool.

Step 1 To access the Bug Search Tool, go to https://tools.cisco.com/bugsearch/search.
Step 2 Sign in with your Cisco.com user ID and password.
Step 3 To look for information about a specific problem, enter the bug ID number in the Search for field, then press Enter.

Alternatively, you can search by product and release.

Open Caveats in Release 11.1(4)
No caveats are open this release.

Resolved Caveats in Release 11.1(4)

HeadlineSeverityIdentifier

Address LibTiff vulnerabilities in Cisco Jabber.2CSCva89914

Open Caveats in Release 11.1(3)
There are no changes to the open caveats since Release 11.1(2). See the Open Caveats in Release 11.1(2)
section for a list of open caveats in this release.

Resolved Caveats in Release 11.1(3)

HeadlineSeverityIdentifier

Jabber client does not allow to enforce STARTTLS as required2CSCux88529

Evaluation of jabber-windows for OpenSSL December 2015 vulnerabilities2CSCux41461

libxml2 December 2015 parsing vulnerabilities2CSCux44307

Jabber 11 Office Integration errorr2CSCuw90724

Jabber for Windows - Unable to load file sourced embedded tab icons3CSCux50088

Displaying 'Unable to load custom contact(s)' in phone only mode3CSCux30543

Jabber crash after second login3CSCux86613

   Cisco Jabber for Windows 11.0.x and 11.1.x Release Notes
20

Introduction
Search for Bugs

https://tools.cisco.com/bugsearch/search
https://bst.cloudapps.cisco.com/bugsearch/bug/CSCva89914
https://tools.cisco.com/bugsearch/bug/CSCux88529
https://tools.cisco.com/bugsearch/bug/CSCux41461
https://tools.cisco.com/bugsearch/bug/CSCux44307
https://tools.cisco.com/bugsearch/bug/CSCuw90724
https://tools.cisco.com/bugsearch/bug/CSCux50088
https://tools.cisco.com/bugsearch/bug/CSCux30543
https://tools.cisco.com/bugsearch/bug/CSCux86613


Open Caveats in Release 11.1(2)

HeadlineSeverityIdentifier

Excessive Jabber calls to WAPI GetUserProfile API hit rate limit2CSCuw96644

Jabber11.1 on T10 tablet can't switch cameras2CSCux01736

Jabber reads incorrect WebEx URL for Join Button3CSCux03658

Jabber custom tab does not load when registered through expressway/MRA3CSCuu48040

Jabber SSO webpage does not login when pressing enter3CSCuu94851

Jabber 11.1 Notes integration error3CSCuw94449

Jabber for Windows 11 produces CJ:109:3 error for IM Only Deployment3CSCuw98292

MSVCP120.dll Error causes Lotus Notes crash after J4W 11.X installation3CSCux10431

Logged in J4W 11 Hangs when put computer to sleep then resume3CSCux11240

Resolved Caveats in Release 11.1(2)

HeadlineSeverityIdentifier

Jabber 100% CPU associated with network change1CSCuw55978

Crash after 5 seconds2CSCuw61909

Location feature won't work with flexible JID2CSCuu63734

Jabber can't register with VXME in phone only mode2CSCuw34245

Jabber for Windows 11 Hangs After Hibernation/Network Change2CSCuw38405

Video doesn't work with Jabber for Windows in deskphone control mode3CSCuw24052

Jabber for Windows crashes when attempting to initiate a chat3CSCuw50839

Jabber for windows keeps rining after signing out on incoming call3CSCuw51541

J4W Calendaring same day appointment doesn't work in Citrix Environment3CSCuw55692

Resolution of phone number (Office) in call history shows 'Unknown'3CSCuw50117
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HeadlineSeverityIdentifier

Contact's Telephone phone number displayed as Unknown for AD group3CSCuw80259

Jabber for windows - Copy doesn't work on images in the Chat3CSCuw71140

Contacts added in MRA displays JID value when moved to corp Wifi3CSCux07096

enablesavechathistorytoexchange not working from OrgAdmin3CSCux01741

Open Caveats in Release 11.1(1)

HeadlineSeverityIdentifier

Jabber 100% CPU associated with network change1CSCuw55978

Location feature wont work with flexible JID2CSCuu63734

Jabber 11 on Windows 10 unable to make calls2CSCuw24341

Jabber for Windows 11 Hangs After Hibernation/Network Change2CSCuw38405

Jabber custom tab does not load when registered through expressway/MRA3CSCuu48040

Jabber SSO webpage does not login when pressing enter3CSCuu94851

MeetingPlugin shouldn't change the calendar type value in some scenarios3CSCuv32755

Both local and remote ringback heard if SIP 180 is followed by 1833CSCuv87622

Jabber for Windows sends incorrect C-Type in SOAP when logging into IMP3CSCuw07694

J4W :Jabber crash in uiautomationcore3CSCuw23422

Video doesn't work with Jabber for Windows in deskphone control mode3CSCuw24052

Jabber for Windows 10.6 do not connect to Voice mail from outside (MRA)3CSCuw33065

Jabber 11.1 crashed after hibernate3CSCuw48299

J4W: Resolution of phone number (Office) in call history shows 'Unknown'3CSCuw50117

Hebrew text is shown in Left-To-Right when entered with English text3CSCuw50276

Jabber for Windows crashes when attempting to initiate a chat3CSCuw50839

Jabber for windows keeps ringing after signing out on incoming call3CSCuw51541
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HeadlineSeverityIdentifier

PTG: Jabber for Windows 11.1 option "Copy to group" is missing3CSCuw47736

Resolved Caveats in Release 11.1(1)

HeadlineSeverityIdentifier

J4W displays "No name" Calling Line ID Presentation is Restricted2CSCuv50522

Edge Server Cert validation not checking Server Cert for a domain2CSCuw61575

Calendar tab is removed from Options when integration type set to None3CSCuu76794

Jabber showing hunt logout notification although not part of huntgroup3CSCuv47418

Jabber windows does not read AD attribute substituted in DisplayName3CSCuw06399

TMS scheduler page doesn't work correctly when used in jabber Custom tab3CSCuw21400

Jabber Spell Check - Polski Directory3CSCuv47389

Jabber does not mark missed call for cause code 19 disconnect3CSCuw10113

J4W sends cancel when placing PSTN calls3CSCuw27832

Cisco Jabber duplicating Streams with Recording server3CSCuw36065

Jabber Windows 10.6+ file transfers use local interface3CSCuv85922

SaveChatHistoryToExchangeOperationMode xml setting is not working3CSCuw37771

In certain scenarios occasionally J4W 11.0 Crash during Conference3CSCuv69545

Jabber certificate pop-up due to incorrect handling3CSCuw50346

Open Caveats in Release 11.1

HeadlineSeverityIdentifier

Location feature wont work with flexible JID2CSCuu63734

J4W displays "No name" Calling Line ID Presentation is Restricted2CSCuv50522

No Audio when Jabber transfer a call to IVR.2CSCuv92779
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HeadlineSeverityIdentifier

Jabber custom tab does not load when registered through expressway/MRA3CSCuu48040

Calendar tab is removed from Options when integration type set to None3CSCuu76794

Calls on Windows 7 lang En to German can hear delayvoice3CSCuu78526

Jabber SSO webpage does not login when pressing enter3CSCuu94851

Jabber MRA audio alerting and decline button remain after call declined3CSCuv05944

MeetingPlugin shouldn't change the calendar type value in some scenarios3CSCuv32755

One way audio on call when using Plantronics D100 headset on jabber3CSCuv34326

Jabber Spell Check - Polski Directory3CSCuv47389

Jabber showing hunt logout notification although not part of huntgroup3CSCuv47418

Intermittently Jabber crashes when attempted to login second time3CSCuv58332

In certain scenarios occasionally J4W 11.0 Crash during Conference3CSCuv69545

Jabber Windows 10.6+ file transfers use local interface3CSCuv85922

Both local and remote ringback heard if SIP 180 is followed by 1833CSCuv87622

Intermittently 1st J2J call after transition to edge drops after ~15 sec3CSCuv89210

Intermittently callers name changes to callees URI after J2J call3CSCuw12790

Resolved Caveats in Release 11.1

HeadlineSeverityIdentifier

Meet Now[Instant webex meeting] not working with j4w 11.03CSCuv64565

Jabber gives directory error on login3CSCuv42281

Jabber Windows device list display is incorrect3CSCuv23937

JavaScript error in IM chat window for offline messages3CSCuv56854

Voicemail Over SSO Edge Fails to Connect after First Sign In3CSCuv52989
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Open Caveats in Release 11.0(1)

HeadlineSeverityIdentifier

J4W displays "No name" Calling Line ID Presentation is Restricted2CSCuv50522

Transfer fails from CAD when used with Jabber on Agent Desktop3CSCuu41838

Calls on Windows 7 lang En to German can hear delayvoice3CSCuu78526

Jabber 10.6.X IM/BFCP screen share issue between MS Surface Pros3CSCuu94669

Jabber SSO webpage does not login when pressing enter3CSCuu94851

Jabber MRA audio alerting and decline button remain after call declined3CSCuv05944

Jabber Windows device list display is incorrect3CSCuv23937

Jabber CSF should failover like physical phones3CSCuv27449

MeetingPlugin shouldn't change the calendar type value in some scenarios3CSCuv32755

Jabber gives directory error on login3CSCuv42281

Cisco Jabber Windows - Occasionally Chat/IM Window Empty3CSCuv43690

Aggressive use of url encoding leads to malformed URL3CSCuv44215

Jabber showing hunt logout notification although not part of huntgroup3CSCuv47418

Jabber occasionally inaccessible when accessing it via Citrix Reciever3CSCuv50368

Resolved Caveats in Release 11.0(1)

HeadlineSeverityIdentifier

Jabber Meeting integration causes a performance issue on Lotus Notes2CSCuu81136

Location feature wont work with flexible JID2CSCuu63734

Directory Search Stops Working after AD account lockout2CSCuu01267

Custom script integration with Jabber 10.6.1(Custom Tab) does not work3CSCut73020

Jabber unable to connect to Lotus Notes3CSCuu57551

Unable to join meeting3CSCuu81060
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https://tools.cisco.com/bugsearch/bug/CSCuu01267
https://tools.cisco.com/bugsearch/bug/CSCut73020
https://tools.cisco.com/bugsearch/bug/CSCuu57551
https://tools.cisco.com/bugsearch/bug/CSCuu81060


HeadlineSeverityIdentifier

Client won't failover to the secondary CUCM when primary is down3CSCut70830

Random hang in csfnetutil3CSCuu98714

Transferred call history log is not the same as deskphones3CSCus56839

Jabber incorrectly stripping international prefixes3CSCuv11909

BIB INVITE may send incorrect codec leading to dropped calls3CSCus48216

Client won't failover to the secondary CUCM when primary is down3CSCut70830

JavaScript error on any popped out conversation3CSCuv04855

Open Caveats in Release 11.0

HeadlineSeverityIdentifier

Consult Transfer fails if queued before 2nd Agent is ready.2CSCuu86246

Directory search stops working after AD account lockout.2CSCuu01267

Jabber Meeting integration causes a performance issue on Lotus Notes.2CSCuu81136

Transferred call history log is not the same as deskphone's.3CSCus56839

Custom script integration with Jabber 10.6.1(Custom Tab) does not work.3CSCut73020

No alert given to users to re-login after downloading group config file.3CSCuu41797

Transfer fails from CAD when used with Jabber on Agent Desktop.3CSCuu41838

Jabber custom tab does not load when registered through Expressway/MRA.3CSCuu48040

Location feature wont work with flexible JID.3CSCuu63734

Intermittent hang on video call.3CSCuu69985

Auto-Away overwrites "On a call" status.3CSCuu72531

Calls on Windows 7 lang English to German can hear delayed voice.3CSCuu78526

AD groupwith an semicolon does not syncmembers to CUCM (server issue).3CSCuu46330

Conference list not correct for Agent who originates call.3CSCuu69290
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HeadlineSeverityIdentifier

Hang detection can kick-in on slow machine startup.3CSCuu71540

Cannot join chat rooms from My Rooms tab.3CSCuu72134

AD Groups contacts cache not retrieved on sign out/sign in.3CSCuu86219

Wrong camera crop&color on ATOM tablet with front & rear cameras.3CSCuu86226

Transfer fails from CAD when used with Jabber on Agent Desktop.3CSCuu86240

Resolved Caveats in Release 11.0

HeadlineSeverityIdentifier

DnsUtils does not filter out 'additional' A records.2CSCuu51007

Softphone cannot log in if device is not in controlled devices.2CSCuv03343

Login fails with non-ASCII characters in password.3CSCuu15104

Cannot register to CUCM via MRA (Cloud SSO is on and Edge SSO is off).3CSCuu38644

SSO not starting minimized.3CSCuu13788

Jabber should do case insensitive comparison of username.3CSCuu40258

Client not using UDS Batch API under Phone only mode.3CSCuu09901

Client missing IM log after pipe character in Outlook chat history.3CSCuu40662

Custom-tab in group config file requires a restart.3CSCuu52975

Error messages in Accounts tab truncated.3CSCuu62806

Can't use a locally stored image as an icon in a custom tab.4CSCup84961

No scroll bar for groups when adding a contact.4CSCur09258

Closed Caveats in Release 11.0

HeadlineSeverityIdentifier

Clicking conversation toolbar does not bring conversation to foreground.3CSCuu13149
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HeadlineSeverityIdentifier

It is not possible to tab out of a custom tab.3CSCuu55122

Jabber hangs & is unresponsive when updating AD group name/removing
members.

3CSCuu46617

Meeting start fails if "Do not save encrypted pages to disk" is on.3CSCut19801

Documentation Resources
The following documents are available for Cisco Jabber for Windows:

• Cisco Jabber for Windows Release Notes—Provides administrators with a summary of information
about the release, including new and changed features, requirements, software limitations and restrictions,
and a caveats overview.

• Cisco Jabber Planning Guide—Provides administrators with background and reference material to plan
the deployment and installation of all Cisco Jabber clients. This guide contains information that helps
administrators make decisions about how they can deploy Cisco Jabber, such as a product overview,
planning considerations, deployment information, and requirements.

• Cisco Jabber Deployment and InstallationGuide—Provides administrators with task-based information
for all Jabber clients. It contains end-to-end client deployment procedures, deployment scenarios and
workflows, infrastructure configuration of services, and client configuration and installation.

• Cisco Jabber for Windows Licensing Information—Provides information on the open source libraries
used by the application.

• Cisco Jabber for Windows Quick Start Guide—Provides end users instructions on how to navigate
Cisco Jabber for Windows for the first time and how to use key features.

• Cisco Jabber for Windows User Guide—Provides end users tasks on how to use the client and
accessibility information.
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